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About RiskyProject Enterprise 

RiskyProject is a project risk management software. RiskyProject can be configured as 

standalone desktop software, which saves files to the set of files for each project, or enterprise 

software, which saves data in the database. As the same installation package is used for both 

desktop and enterprise versions of the software, switching from one version to another is quick 

and easy. You can switch from one configuration to another using the RiskyProject License 

Wizard. RiskyProject Enterprise is a flexible project portfolio risk analysis and management 

system.  

The enterprise system is comprised of three main components: 

RiskyProject Server: The server contains the RiskyProject database. For the current version of 

RiskyProject, the server can be run on a Microsoft SQL Server. The database contains all project 

and risk data including Monte Carlo simulation results. 

RiskyProject Enterprise Desktop Client: The enterprise client is required to perform 

quantitative risk analysis and management. The client used with enterprise software can be the 

Professional, Lite, or Risk Register modules.  If enterprise client is RiskyProject Professional or 

RiskyProject Lite, the enterprise client includes three Portfolio views: Risked Projects view, 

Portfolio Gantt view and Project Portfolio view. These are portfolio-level views of project 

schedules and costs.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

RiskyProject Installation and Configuration 

Before you start working with RiskyProject Enterprise, the RiskyProject database must be 

configured and user names, passwords and portfolio settings must be defined. Please read the 

RiskyProject Enterprise Administrator’s Guide for additional information.  
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About RiskyProject License Types 

When you start RiskyProject Professional and RiskyProject Lite for the first time on your 

computer, you will be prompted to define the license type or mode of RiskyProject operation. 

When installing RiskyProject, you may choose between three installation modes: 

• Enterprise Client Mode: RiskyProject will be connected to the database. In this mode, 

you can save projects to the database or in a file format. In addition, this mode contains 

additional views (Portfolio Gantt, Project Portfolio and Risked Projects) for managing 

and analyzing your project portfolio. You must have an enterprise client license to enable 

this mode. 

• Regular Desktop Mode: the desktop license is not connected to a database (standalone 

RiskyProject). Projects can only be saved in RiskyProject’s file format (*.alm). 

• Trial Mode: the trial license is a full version of the desktop license that can be used for 

30 days, at which time you must enter a license code to continue using the software. 

About This Document 

Installed versions of RiskyProject Professional, RiskyProject Lite and RiskyProject Risk Register 

can be connected to the database or run as standalone desktop applications.  

This document describes only specific features of the RiskyProject Enterprise desktop client 

(features which apply when RiskyProject is connected to the database). For all other features, 

which are identical in Enterprise client mode and Regular desktop mode, please consult with the 

RiskyProject User Guide or Getting Started with RiskyProject Guide. 

Updating Your License 

If you have recently purchased or upgraded your license, you must update it. 

To update your license type: 

1. Click the Tools tab. In the RiskyProject Configuration group, click Update RiskyProject 

License. The License Wizard opens. 

2. Select the license type (Trial, Regular or Enterprise). If you have already activated your 

license, only the alternate license type will be available. 

3. Click Next.  

4. If you selected Regular Desktop license and did not validate your license code on your 

computer before, input your new license code and click Next. 

Logging on to RiskyProject Enterprise 

To logon to RiskyProject Enterprise, you must have a database connection set up. 

To logon: 

1. Launch RiskyProject. The Logon window opens. 

2. Enter in your name and password. 

3. Click OK. 
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When you logon to RiskyProject for the first time, your system Administrator will issue you a 

temporary password. You will need to change this password after logon in the subsequent dialog.  

 

When logging on to RiskyProject Enterprise, you may switch your desktop or trial license by clicking on 

Start regular desktop license (no database).

 

Switching Between Enterprise and Standalone Desktop 
Configurations 

You may switch between Enterprise and Standalone desktop configurations of RiskyProject, and 

vice versa, at any moment. To do so, use the Update RiskyProject License button under the 

Tools pane on the toolbar. 

 

• If you switch from Enterprise configuration to standalone desktop configuration you must 

have a license for RiskyProject standalone on your computer. If an Enterprise configuration is 

saved in the database, the standalone license will be saved in the Windows registry.  

• If you switch from standalone desktop configuration to enterprise configuration, you need to 

define database connection properties in the manner outlined in the RiskyProject Enterprise 

Administrator’s Guide. 

• If you are in Enterprise mode, you may want to connect to a different database. Click on 

Update RiskyProject License and select Enterprise: update database parameters. You 

will be prompted to define database connection properties. 

 

You may switch from Enterprise configuration to standalone desktop configuration by clicking on Start 

regular desktop license (no database) using the RiskyProject Enterprise logon dialog.  
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Chapter 2: Managing Projects 



    

10 

 

About Organizing Your Project Portfolio 

You may organize a portfolio similarly to how you organize a project, using summary tasks and 

sub tasks. In the Portfolio views, programs are represented as summary projects and their data is 

the rollup of all projects listed under the specific program.  

Creating a Portfolio Hierarchy 

By default, RiskyProject Enterprise will “add” all projects in your database to the Project 

Portfolio. All projects will be considered to be part of your portfolio, but will not be organized in 

a hierarchical structure: Portfolio > Programs > Projects. Your portfolio can be organized to 

reflect any types of business units, regions, project types etc.  If your projects are not organized or 

you are adding a new project to the database, you will need to organize your Portfolio.  

To create a project or program: 

1. Click the Projects tab. In the Project Views group, click any project view. In these views, 

you will be able to see all your projects. In a new database, there will be no projects shown in 

the views. 

2. To begin building the hierarchy and adding projects, first create a project. This will serve as a 

starting point to begin building the hierarchy.  If the project contains any tasks or resources, it 

will be an actual project. Otherwise it will be a project placeholder. Project placeholders will 

not have a Gantt bar associated with them in any Project views: Portfolio Gantt, Risked 

Project, and Project Portfolio views. To add the initial project, click in the top row and type 

in a descriptive name.  

 

3. To add the project to the program, right-click on the project directly below the Program and 

choose Indent.  

4. To create an empty row, right-click on the Project ID and click on Insert Project. 

5. By repeating these steps, you can create a hierarchy which will include multiple programs and 

projects. 

Opening Projects 

To open a project: 

1. Select the project in one of the Project views. 

2. Click the Projects tab, and in the Projects group click Open Project or, 

• Double click on Project ID or 

• Right click on Project ID and click on Open Project on the shortcut menu 

The project will open in the Schedule > Project Views. 

Add a placeholder project.  

To create summary projects 
or programs use 
Indent/Outdent buttons.  
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You can open summary projects or subprojects as long as you have permissions to do so. 

However, if you open a summary project, you cannot add a project schedule or resources. You 

may only manage risks associated with the summary project. 

 

If you open a placeholder project, it will not have any tasks or resources associated with it. Once you 

add at least one task, resource or risk, it will become an active project. Each active project is 

represented by  a Gantt bar in the Portfolio Gantt view. A project can contain qualititative risks.

 

About the Current Project 

Once you open a project it becomes the current project, and schedule or risk data that is added, 

modified or deleted is added at the current project level. The current project is indicated by either 

a blue bar for project or red bar for summary project at the top of the RiskyProject workspace. 

The current project is indicated with italics and an arrow  next to the project name as in the 

below example: 

 

A red asterix symbol indicates that the project is currently being edited.  

 

If the Current Project bar is not visible, then you are currently viewing the Portfolio. This is 

especially important if you are in the Risks views, as this would mean you are looking at the Portfolio 

level risk views.  
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Refreshing the Hierarchy 

The hierarchy will be read from the database each time you open any Project view: Project Gantt, 

Risked Projects, or Project Portfolio. If another concurrent user has modified the hierarchy while 

you are in any project view, you may need to refresh the project portfolio.  

To refresh the project hierarchy: 

1. Click the Projects tab. 

2. Click Refresh Portfolio. 

Locking and Unlocking Projects 

Only one user can open a project at a time. Projects will be locked for all other users if somebody 

opens a project. Locked projects are indicated by an icon  next to the project name. A project 

will be automatically unlocked when a project is closed. 

If a project is locked it can be unlocked by an administrator. As an example, it may be necessary 

to do so if a user left the project open for a long time period.  

To unlock a project or group of projects: 

1. Click the Projects tab. In the Project Views group, click any Project view.  

2. Select the project you would like to unlock.  

3. Right-click on the project ID and from the shortcut menu, click Unlock Project. 

Blue bar indicates the 
current project. 

Red bar indicates a 
current summary project 

An arrow next to the 
project name indicates 
current project 

Click here to close 
project  
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Modifying Projects 

To modify a project schedule, you must open it. If the project has risks and uncertainties, they 

will be reflected in the project portfolio as soon the project is saved. In particular, risk scores will 

be re-calculated and the Project Gantt chart will be updated. Project names and project priorities 

can be updated without opening the project. You may be required to modify the project start time.  

To modify a project start time: 

1. Open the project. 

2. Click the Schedule tab, and in the Settings and Options group, click Project Settings. 

3. Click on the Project Start Time box. A calendar opens.  

4. Select the new project start time from the calendar. 

5. Click OK. Close the project and the new start time will be reflected in the project hierarchy. 

Closing a Project 

To close the Current Project: 

1. Click on the X on the Current Project bar at the top of RiskyProject workspace, 

2. Click the Projects tab and then Close Project, or 

3. Right-click on the project ID and from the shortcut menu, click Close Project. 

If the project has not been saved, you will be prompted to save changes. 

Saving a Project 

You can add or save an imported project to the database.  

To save a project: 

1. In the Projects view, select the project that you want to save or select an empty project row. 

2. In the Projects group, click Save or Save As. The Save Project dialog box opens. The Save 

Project dialog box allows you to insert the project into your portfolio hierarchy at any level. 
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3. From the hierarchy, select the position where you want to insert or save the project. You can 

rename the project if required in the Project Name box. 

4. Click Save. 

Creating a New Project without a Placeholder 

If you don’t have a current project opened, you can create one by adding tasks to the Project 

View or resources to the Resource View. A new current project will be created automatically and 

added to the bottom of the hierarchy.  

 

 

You are also able to rename or save this project to a different position in the project hierarchy. 

Importing a Project File to the Database 

Importing projects allows you to import RiskyProject project files into your database and 

portfolio. These files are created by RiskyProject when using the standalone desktop mode. 

To import a file: 

1. Click on File -> Import -> RiskyProject (ALM) file… .  

2. You can also click the Projects tab. In the Project Views group, click any Project view. In 

the Export/Import group, click the Import from file. The Open dialog box opens. 

3. Navigate to the file (*.alm) and click Open. RiskyProject will check if the project file has any 

risks or mitigation plans. If it does the Insert risks and mitigation plans from file to Risk 

Register dialog box opens. This dialog box allows you to add, ignore or match the risks or 

The new project will be added 
to the bottom of the hierarchy.  

Red star indicates that project 
is currently being edited  

When you start entering task 
or resource information, the 
new project will become the 
current project  



RiskyProject Enterprise User’s Guide 

 

15 

 

plans to existing ones (rename). If you do not want to use this process click Skip. If the 

project has a schedule you will also be prompted if you would like to run a simulation.  

4. Select the hierarchy location where you want to place the project. You can rename the project 

if required in the Project Name box. 

5. Select the hierarchy location where you want to place the project. You can rename the project 

in the Project Name box. 

6. If you select project, which already exists in the hierarchy, you have an option to overwrite 

existing project or insert project after the selected project.  

7. If you choose Overwrite existing file, you have an option to apply risks and uncertainties to 

the imported project from the project you overwrite. For example, you import Project A and 

overwrite Project B. Project B has risks assigned to certain tasks and uncertainties in task 

duration. You have an option to apply risks assignment and uncertainties from Project B to 

Project A based on Task unique ID (GUID field). Only duration and start time uncertainties 

will be applied. Fixed cost, work, income and lag uncertainties will be not applied to 

imported project. 

Importing an XML or XER Files 

Importing xml files allows you to import supported xml project files (Microsoft Project xml 

schema) as well as Primavera P6 XER files into your database and portfolio. The XML/XER file 

import procedure is the same as Import a Project File, but risks and mitigation plans import step is 

omitted. 

To import an XML or XER file: 

1. Click on File -> Import -> Microsoft Project (XML)… or Oracle Primavera (XER)… .  

2. For XML file import you can also click the Projects tab. In the Project Views group, click 

any Project view. In the Export/Import group, click the Import from XML. The Open 

dialog box opens. 

3. Navigate to the file (*.xer or *.xml) and click Open. 

4. Select the hierarchy location where you want to place the project. You can rename the project 

if required in the Project Name box. 

5. If you select project, which already exists in the hierarchy, you have an option to overwrite 

existing project or insert project after the selected project.  

6. If you choose Overwrite existing file, you have an option to apply risks and uncertainties to 

the imported project from the project you overwrite. 

Importing Envision Schedules 

You can import schedule from Envision database. Connection to Envision database can be 

configured in Preferences dialog (see About Preferences). 

To import an Envision Schedule: 

1. Click on File -> Import -> Envision Schedule… .  

2. If you did not configure a connection in Preferences dialog, you can configure it here. 

3. Select project from Envision database and click OK. 
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4. Select the hierarchy location where you want to place the project. You can rename the project 

if required in the Project Name box. 

5. If you select project, while already exists in the hierarchy, you have an option to overwrite 

existing project or insert project after the selected project.  

6. If you choose Overwrite existing file, you have an option to apply risks and uncertainties to 

the imported project from the project you overwrite. The procedure is described in Import a 

Project File. 

Creating projects from Microsoft Project 

If you are using the RiskyProject Add-in for Microsoft Project and want to move the project 

data to RiskyProject Enterprise, you will be required to logon to the RiskyProject database in 

which you want to add the project. You can then add the project to your portfolio. You may 

rename or save this project to a different place at any point in the project hierarchy. 

 

 

 

 

 

 

 

 

 

If your schedule from Microsoft Project is currently in the database, it will remain linked to your 

Microsoft Project file; therefore, if you make any changes to the schedule in Microsoft Project it 

will be reflected in the schedule within RiskyProject. 

Exporting a Project 

You can export your project files to the RiskyProject file format (*.alm). 

To export a project to a file: 

1. Click the Projects tab. In the Project Views group, click any Project view.  

2. Select the project you want to export to a file.   

3. In the Export/Import group, click the Export to File button. The Save As dialog box opens. 

4. Navigate to the folder to which you want to save the file. 

5. Enter a name in the File Name box and click Save.  

  

 

New project is created and 
added to the project hierarchy  

Microsoft Project RiskyProject 
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Exporting a Project Schedule in XML Format 

You can export your project files to the Microsoft Project xml file format (*.xml) 

To export a project as xml: 

1. Click the Projects tab. In the Project Views group, click any Portfolio view.  

2. Select the project you want to export to a file.   

3. In the Export/Import group, click the Export to XML button. The Export Schedule dialog 

box opens. You can  select either the original schedule or results of the Monte Carlo 

simulation.  

 

4. Select the schedule results option that you would like to export and click OK. 

Copying and Pasting a Project 

You can copy projects and paste projects in your portfolio. 

To copy a project: 

1. In any Project view, select the project that you want to copy. 

2. Right-click and choose Copy from the shortcut.  

3. Select a row in your portfolio where you want to place the copied file. 

4. Right-click and choose Paste. The copy of the file is placed in the new location. 

• If you select a row with a project in it, the project will be inserted above the selected row. 

It will not overwrite the existing project. 

• By default, the copy of the project will have the same name. You should rename the 

copy. 

 
You can use Copy and Paste to move projects to a different location in the hierarchy.

 

  



    

18 

 

Deleting a Project 

Deleting a project deletes it from both the hierarchy and the database. 

To delete a project: 

1. In any Project view, select the project that you want to delete.  

2. Right-click and from the shortcut menu choose Delete. The project will be deleted from the 

database. 

 

• You cannot delete the current project.  You must close a  project before you can delete it. 

• You must have appropriate permissions to be able to delete a project. 
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About the Project Views 

The desktop client for RiskyProject Enterprise comes with 3 additional views: 

• Portfolio Gantt  

• Risked Projects 

• Project Portfolio 

About the Portfolio Gantt View 

The Portfolio Gantt view is a Gantt chart view of  your project portfolio. In the Portfolio 

Hierarchy you can view your programs and projects. If you have permission, you can also modify 

the hierarchy by adding, deleting, moving etc. programs or projects.  

 

 

Double-click on a Gantt bar to view detailed information about a selected project. See Viewing 

Project Details in the Portfolio Views for more information. 

Using Portfolio Gantt view you can visualize: 

• Projects with risks and uncertainties alongside original project schedules 

• Low and high project durations 

• Project performance - tracking bars will be shown 

• Low and high project results, which may be shown separately 

To view the different settings listed above on the Portfolio Gantt view: 

• Right-click on the Gantt chart  

• Make a selection from the shortcut menu: show current schedule, show both Low/High 

Results, etc. 

 

 

Portfolio Hierarchy  

Portfolio Gantt chart  

Right click on Gantt pane 
brings you this shortcut menu  

Project with risks and 

uncertainties  

Original project schedule  
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Low and high results are associated with the particular percentile; definition of low and high results 

can be changed in Portfolio Options (Calculation tab). See About Portfolio Options and Preferences for 

more information. 

 

About the Risked Projects View 

The Risked Project view shows the relative risk associated with a project versus project duration 

or total project cost. The risk is expressed as: 

• project standard deviation of task duration or cost 

• maximum or minimum values 

• ranges: the difference between maximum and minimum values 

• percentiles, or Project Value at Risk (PVatRTM).  

In a well-balanced portfolio, different projects will have similar levels of risk. However, if the 

relative risk associated with a project is higher than similar projects, the project should be flagged 

for additional analysis. Alternatively, if a project has less relative risk, it may represent an 

opportunity where additional cost or schedule risk could be transferred to it to mitigate projects 

with higher risk in your portfolio.  

Risked Projects view is implemented similarly to Risk Chart view for the project schedule. Risk 

Chart view shows a bubble chart for the tasks, while Risked Projects view shows a bubble chart 

for the projects. To read more about how to view and use the Risked Projects view, see Risk 

Chart in RiskyProject User Guide. 

Project Value at Risk (PVatRTM) concept was developed by Nicki Kons. See Kons, N. 2016. PVaR - 

Project Value at Risk. CreateSpace Independent Publishing Platform (April 28, 2016). 

 

Select a risk indicator 

Select the projects to 
display on the chart.  

Choose the value 
measure: duration or 
cost 

 
This project has higher 
risk relative to projects 
with similar duration 
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About the Project Portfolio View 

The Project Portfolio view is a table, which displays the results of a probabilistic analysis of the 

projects in your portfolio.  This view can be used for both analysis and reporting. You can modify 

the data that appears in this view by adding or hiding columns.  

 

Viewing Project Details in the Portfolio Views 

You can view general project information as well as the simulation results for projects . 

To view project details: 

• Right-click on the Project ID and select Project Details from the shortcut menu. 

Double-click on a project’s Gantt bar on a Project Gantt view, or 

• Click the Projects tab and then Main Project Information. 

 

 
 

The general project information for the selected project will open. 

Add or hide columns  



    

22 

 

 

 

• Double-clicking on any chart will bring up the detailed view for each chart. 

• You may update priorities, project name, description, and other project information here. 

 

 

Simulation results for 
selected project  

Project Risk Score Meters 
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About Project Priorities  

The Priority field indicates the level of importance given to the project. The project priority is 

then used in calculating the risk score for the project. Projects with higher priority will be given a 

higher weighting in calculating the risk impact. 

Priority levels range from 0% -  100%. The lowest priority is 0%. The default priority is 100%. 

Summary projects (programs) don’t have priorities. 

Priorities can be changed in any Project view: Portfolio Gantt, Risked Projects, and Project 

Portfolio. You don’t need to open individual projects to change the project priority. You must 

have appropriate permissions to change a priority: 

• Administrators can change priorities for any project 

• Managers can change priorities in projects for which he/she has permission 

• Users cannot change priorities 

Project priorities are used in the following calculations: 

1. Project risk scores for non-schedule risks are multiplied on project priority. Read The Project 

Risk Score and Project Ranking for more information. 

2. Risk impact is multiplied on project priority. Here is an example. The project with project 

priority 50% has a summary project:  

Project Name Priority 

Summary Project  

   Project #1 50% 

Project #1 has a risk assigned to it. For Project #1, the risk register would look like: 

Risk Name Probability Impact  Score 

Risk 1 50% 80% 40% 

 A risk register with the same risk for a summary project would look like: 

Risk Name Probability Impact  Score 

Risk 1 50% 40% 20% 

The risk impact is multiplied on Project #1 priority = 50% for the summary project only. 

 

To reflect project priority in the risk impacts you should open, recalculate and save the project. 
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About Project Risk Scores and Rankings 

Project risk scores represent the level of risk in the project. The project risk score allows you to 

compare and rank projects based on their risk exposure. Project risk scores are shown in the  

Portfolio Gantt and Project Portfolio views. 

RiskyProject calculates three risk scores separately: 

• For duration 

• For cost 

• For non-schedule risk categories 

How Cost and Schedule Risk Scores Are Calculated 

Project duration score is calculated using the following formula: 

 

 

 

 

Where: 

Risked Duration – could be mean project duration as a result of analysis, mean project duration 

plus a standard deviation of duration, or a certain percentile of the entire project duration. 

Original Duration - Original (baseline) project duration with no risks and uncertainties 

• If the project does not have duration risks, the Duration score will be equal 1.  

• If the Duration risk score is > 1, the project has threats related to duration.  

• If the Duration risk score is < 1, the project has opportunities related to duration.  

How Non-Schedule and Cost Risk Scores Are Calculated 

Risk scores for non-schedule or cost risks are calculated in the following manner: 

1. For each project and category there is an array for risk results. For example, if there are two 

risks “Quality of installation” (probability 50%, impact 30%) and “Quality of manufacturing” 

(probability 20%, impact 40%), the array for the quality category may look like this: 

Iteration Cumulative Impact 

1 0 

2 30% + 40% = 70% 

3 30% 

4 0 

5 40% 

6 0 

          Risked Duration 

Score = -------------------------------- 

                    Original Duration 
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7 0 

8 30% 

9 30% 

10 30% 

2. The mean of this array is calculated and multiplied by the weight for each non-schedule risk 

category 

3. The sum of values from Step 2 is calculated for the particular project for all risk categories; 

this number represents the absolute non-schedule risk score for the particular project. 

4. Absolute non-schedule risk scores for all projects are normalized in such a way that: 

• if a project does not have any risks, the score will = 1 

• if a project has opportunities, the score will be < 1 

• if a project has threats, the score will be > 1. 

In this way the risk scores for non-schedule risks will be compatible with risk scores for 

duration and cost.  

Risk Meters 

Project risk score factoring in duration and cost only is displayed using the Risk Meter in Project 

Summary view and the Project Information dialog (see Viewing Project Details in the Portfolio 

Views). 

 
 

 

 

Click here to view or 
adjust calculation 
formula or scale. You can 
make adjustments only 
in Project Summary 
View.  

Blue area 
represents 
opportunity  

Actual project risk 

score number 
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About Portfolio Options and Preferences 

In RiskyProject Enterprise, there are three types of project defaults that can be set: 

• Portfolio Options are common settings for all projects in the portfolio - these options 

include units, currencies, defaults calculation parameters, among others. Portfolio settings 

are applied to each project setting either when the project is created (imported) or each 

time the project is opened. 

• Project Options can be adjusted separately for each project; Project Options and 

Portfolio Options are very similar.  

• Preferences are specific to each computer and can be set by any user.  

To change Portfolio Options or Preferences: 

1. Click the Projects tab. 

2. In the Portfolio Settings group, click Portfolio Options or Preferences. 

 

 

 

 

To Change Project Options:  

1. Open a project. 

2. Click the Schedule tab. 

3. In the Settings and Options group, click Project Options. 

 

Portfolio Options 

Preferences 
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About Portfolio Options 

Portfolio options set the defaults that are applied to all new projects in the database and require 

administrative permissions to configure. 

The Portfolio Options dialog box includes seven tabs:  

• General tab to set up general information regarding the organization and can be used for 

reporting purposes 

• Duration tab to define the calculation of task durations 

• Calendar tab to calculate project schedules 

• Units tab to define how time units are displayed or input 

• Calculation tab to set up default calculation parameters 

• Cost tab to input default cost parameters and calculations 

• Risk tab to define defaults for the Global and Local risks 

To read more about Options and Settings, see Setting up your Projects in the RiskyProject User 

Guide. 

 

The Portfolio calendar is used to display the Portfolio Gantt chart. The Portfolio Calendar is always  

the Standard calendar. 

 

How Portfolio Options Are Applied 

These are two ways by which portfolio options are applied to a particular project: 

• Apply portfolio options to all new or imported projects - the user may change individual 

project options at any time. 

• Use only portfolio options - inividual project options cannot be changed. 

To change these rules:  

1. Click the Projects tab. 

2. In the Portfolio Settings group, click Project Options. 

3. Click the General tab. 

4. Select on the rules to apply to the Portfolio. 

5. Click OK. 

Individual Risk Matrixes for Different Projects or Users 

By default, there is one global risk matrix for all users or projects. However, you have the option 

to assign individual risk matrixes for different projects or users. If you assign individual risk 

matrixes for a particular summary project, these will automatically be propagated to all 

subprojects. If you assign individual matrixes to the users, these will be assigned to all users 

within a selected user group in your organizational breakdown structure. 

To define individual matrixes for users and projects:  

1. Click the Risks tab and then click on Format Risk Matrix 
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2. Click on Advanced Settings 

3. Select Risk Matrix Settings: global, per project or per user 

About Risk Visibility (Approval) Rules 

When a new risk is added to the project, this risk will be visible for the current project, the 

immediate summary project, all summary projects for the current project, and the entire project 

portfolio. The visibility rules are defined in the Risk tab of the Portfolio Options dialog.  

 

You may always change risk visibility for a particular risk using the Risk Information dialog box.  A 

manager or administrator can make a risk or group of risks visible by clicking on the risk ID and 

selecting “Make Visible (Approve)” from the shortcut menu.  

 

Here are examples which demonstrate the ways in which particular risks will be visible for 

different projects within a project hieararchy, depending on risk visibility rules. 

Enterprise Level (all projects) All Summary Projects 

  

Only Immediate Summary Project Current Project 

  

To Define Risk Visibility Rules:  

1. Click the Project tab. In the Portfolio Settings group, click Portfolio Options. 

2. Click the Risk tab 

3. Click the Risk Visibility (Approval) Rules. 

4. Select one of the four visibility (approval) rules. 

5. Click OK. 
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About Preferences 

The Preferences dialog allows individual users to set up preferences for project desktop behavior 

and appearance, as well as setting up default export and 3rd party settings: 

1. Select the project view that will appear whenever RiskyProject is opened from the Default 

View list. “***LAST VIEW***” will automatically load the RiskyProject session which 

was opened most recently. 

2. Select or clear the Show or hide startup view check boxes to enable or disable the workflow 

bar, legends and splash screens. 

Click on Envision Database Connection Settings to configure integration with the Proteus 

Envision® database. This can be done the same way as configuration for connecting with 

RiskyProject database, as outlined in the RiskyProject Enterprise Administrator’s Guide.  
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Chapter 3: Managing Risks, Mitigation 
and Response Plans, 
Incidents 
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Introduction to Managing Enterprise Risks  

The Risk Register and Mitigation/Response Plans in RiskyProject Enterprise behave in a manner 

similar to the standalone desktop version of RiskyProject. However, there are a number of 

important differences: 

• Each time you add a risk to the Risk Register in RiskyProject Enterprise, it will be 

instantly saved to the database. You can add risks using the Risk Register view or the 

Risk tab in Task Information or Resource Information dialog boxes in a project. 

• Similarly, if you add mitigation or response plans, these will be instantly saved to the 

database and shared between different projects. 

• You must have permissions to add, modify or delete risks, mitigation, and response plans. 

• Once added to the register, you can share risks among different projects based on their 

portfolio visibility (approval) settings. 

• Risk cost calculation for summary project and on enterprise level includes risk cost for 

subprojects. 

• You may choose to assign risks to specific projects, summary projects, or the enterprise 

level of the project hierarchy.  

• You can assign different probabilities and impacts for the same risk to different projects 

or levels of the hierarchy. 

• Risks can be visible (approved) in some projects and hidden (not approved) in others. 

• Risk may have documents associated with them - documents can be any files, including 

files found in Microsoft Word, Microsoft Excel, Microsoft Power Point, JPEG or Bitmap 

images, PDF files, among others. 

This section focuses on features specific to the Risk Register in Enterprise. The RiskyProject 

User Guide contains more detailed information regarding how to use the Risk Register.  
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How to Setup Risk Register  

Risk Register view needs to be defined in advance and saved in the database to ensure 

consistency for all users and projects. Use the following workflow to setup Risk Register: 

1. Define risk categories. If you define Risk Register columns to input risk probabilities and 

impacts you cannot change risk categories unless you hide these columns. Therefore, it is 

important to define risk categories as a first step. To define risk categories go to Risks -> 

Risk Categories. 

2. Define risk properties: Risks -> Risk Properties. 

3. Define risk matrix settings (Risks -> Format Risk Matrix): 

A. Names and number of cell of risk matrix for each risk category 

B. How probability and impact will be presented in Risk Register 

C. Colors for different cells 

D. Risk tolerance: relative number of cells for different colors 

E. Order and names of bars on Risk Trend Chart 

F. Risk Impact Calculation Algorithm: sum of impact for all categories or maximum impact 

of all categories 

G. How the risk matrix is set: for all users and organizational units, for projects, or for 

organizational units 

If you the risk matrix is set for Organizational Unit, when you logon, the risk matrix setting 

will be based upon you organizational unit membership. If a risk matrix is not defined for an 

a specific Organizational Unit project, RiskyProject will use the default risk matrix. 

If Risk Matrixes are defined by project, RiskyProject will be present different risk matrixes 

based upon the project settings. If the risk matrix is not defined for a project, RiskyProject 

will use the default risk matrix. 
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4. Define columns to be presented within Risk Register for different views (tabs). In addition to 

entering all risk properties Risk Register allows you to input current probabilities and 

impacts. To define columns click on Risk Register header and select column from drop down 

list. Within a dropdown list you will find different types columns for probability, impact and 

score. You can enter probabilities impacts and scores for each category, as well as display 

original, pre- and post-mitigation probabilities and impacts. 

 

In many cases probabilities for all risk categories can be the same. If such case you can define 

probability column only for one category, for example probabilty for the schedule. If you enter 

this probability in Risk Register, RiskyProject will automaticaly assign the same value to all other 

risk categories, such as probability for cost or probability for safety. 

 

Below is an example how to define columns for impact. Columns for probabilities and scores are 

defined similarly. 

A. Select risk matrix and enter description.  

You can have  

a). One risk matrix for all projects and org. units 

b). For each project 

c). For each organizational unit 

B. Select project or Org Unit  C. Assign matrix to project or Org Unit  
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Please read RiskyProject User Guide for more information how to define categories, properties, 

risk matrix settings, and columns. 

 

 

Selecting probability/impact/score columns for Risk Register 

Impact (Original): First impact value, which was 
entered for this risk - Read only 

Impact (Post-Mitigation and Pre-Mitigation): Calculated 
Impact for all categories - Read only 

Impact (for each category): Current Impact value for 
individual category: Editable – pre-mitigation, read-
only for post mitigation 
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About Risk Visibility and Risk Assignment 

Each risk can be visible and assigned to specific projects. Visibility and assignment are not 

identical: 

Visibility Assignment 

Visibility means that a risk can be 

accessible for the specific project, summary 

project and at the enterprise level. 

If a risk is not visible, it cannot be assigned to 

any project. 

Assignment means that a risk may occur 

(affect) the specific project, summary 

project or at the enterprise level. 

The user specifically attaches a risk to a 

project. Only a visible risk can be assigned. 

 

When you create a new risk, it will inherit the default visibility settings. Default visibility is 

defined in Portfolio Options. See Risk Visibility (Approval) Rules for more information. 

Default visibility can be set for: 

• Projects which are currently opened (Current Project)  

• Only the Immediate Summary Project 

• All Summary projects for this project 

• At the Enterprise Level 

After a risk is created, you can change the visibility if you have permissions to the projects in 

which you want to make this risk visible. 

  

These risks 

are visible in 

this project 

These risks are 

assigned to this 

project 
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Assigning Risks to Projects  

Risk must be assigned to a specific project, a summary project, or at the enterprise (upper) level 

of the project hierarchy.   

To assign a risk to a project or program: 

1. Open the project to which you want to assign the risk; if you do not open a project or 

program, the risk will be assigned to the enterprise (upper) level of the project hierarchy.  

 

2. Click the Risks tab and then in the Risk Views group, click Risk Register or Risk 

Properties. 

3. Double-click on a Risk ID to open the Risk Information dialog box. 

4. Enter all risk properties including probabilities and impacts; you may define different risk 

alternatives, risk categories, moment of risk (if a risk is assigned to a task or resource). For 

more information, please read the RiskyProject User Guide. 

5. Click OK.  

  

The current project bar indicates to 
the active risk register level  

Risks that have been assigned at the 
program level have a name (they are 
visible) but no assignment 

These risks are global for this project 
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To view risk register on enterprise level: 

If you do not have an open project or program (no blue or red bars), this indicates you are looking 

at the enterprise risk register: 

 

 

To view the projects to which a risk is assigned: 

When viewing the portfolio or program risk register, the Risk Assigned To field displays the 

projects (or programs) to which a risk is assigned.  

In the above example, the Current Project bar is not open, which indicates that the you are 

looking at the Enterprise level risk register. If the risk is assigned to more than one project, the 

Risk Assigned To will become a drop-down list. Click on the list to view all of the projects to 

which the risk is assigned.  

Changing Risk Visibility  

After a risk is created, you may change the list of projects within which the risk is visible. 

To change risk visibility: 

1. Click the Risks tab and then in the Risk Views group, click Risk Register  

2. Double-click on a Risk ID to open the Risk Information dialog box. 

3. Click the Visibility tab. 

4. Select a visibility level. You may choose to make this risk visible: 

• For all projects/all levels of the hierarchy 

This column shows projects this 
risk is assigned to. 

These risks are assigned to these 
projects. Other risks are assigned 
at the enterprise level. 

Current Project bar is not shown, therefore, 
this is the enterprise risk register. 

This risk is not assigned to any projects. 
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• Only at the enterprise level of the hierarchy 

• For specific projects 

5. If you need to make your risk visible for a particular project, select projects in which you 

would like your project to be visible. 

6. Click OK.  

 

  

Automatically Assign Risks to Upper Levels of the Hierarchy 

In the above example, the risk “Issue with the hardware” is visible for Project 7 and for Summary 

Project 7. Here is an important rule: 

 

 

 

In our previous example, if you assign the risk “Issue with the hardware” to Project 7, it will be 

automatically assigned to Summary Project 3.  

To view the projects or programs to which a risk is assigned: 

1. Open a summary project (Summary Project 3 in our example). 

2. Click the Risks tab and then in the Risk Views group, click Risk Register or Risk 

Properties. 

3. Double-click on a Risk ID to open the Risk Information dialog box. 

4. Click the Probability and Outcome tab (if you do not have a project schedule) or Assign to 

Tasks or Resources Tab (if you have a project schedule).  

Change risk visibility 
here  

The risk is visible in 
these projects  

If you assign a risk to a low level of the hierarchy, it will be automatically assigned 

to levels directly above it unless visibility is explicitly limited to the project. 

User must have permissions to 
access all projects to be able to select 
“All Projects” and “Only Enterprise 
level” visibility. 
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5. You will be able to see the risk, which is automatically assigned to the summary project. 

Column From Project indicates where the risk was assigned originally. The original 

assignment can be changed here. You would have to go to the sub project (Project 7 in our 

example) to make any changes to the risk assignment. 

 

 

The same process of automatic risk assignment also works at the enterprise level. Therefore, if a 

risk is visible at the enterprise level and you assign it to a particular project, the risk will be 

automatically assigned to the enterprise level. 

 

You may assign the risk to a summary level, even it is already assigned to the project level. This is 

useful in situations where the project level and summary level risk is assigned to different categories. 

For example, at the project level “Pipeline Crack”  is a quality risk, whereas on the portfolio level the 

same risk can also be defined as a public relations risk. 

 

• When you change the visibility for the risk, it will automatically be assigned to the associated 

summary project or to the enterprise level. 

• You must have appropriate permissions to make a risk visible for a summary project or at the 

enterprise level. If you do not have these permissions, your risk will not be automatically 

assigned to the upper level of the hierarchy. 

• Automatic risk assignment only goes upward from lower to higher levels of the hierarchy 

(summary project and enterprise level), but not from summary projects down to sub projects. 

• Original risk assignments may have multiple mutually-exclusive alternatives with different 

probabilities and impacts. These risk assignments may also have a particular distribution of 

Automatic risk assignment (from projects)  

Outcomes and changes are greyed out.  
From Project indicates where the risk was assigned 
originally 

You can delete automatic 
risk assignment here, but 
you would need to modify it 
in the original project 

Risk is assigned to this level of hierarchy. 
Probabilities and impacts can be changed here. 
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risk outcomes. When a risk is automatically assigned to the upper levels of the hierarchy, one 

integrated risk assignment will be generated, the impact and probability of which will be 

equivalent to the original risk assignment. 

 

About Hidden Risks 

Risks that are not visible for certain projects will be flagged as hidden for those projects. They 

will still exist in the risk register, but only administrators, managers and the particular 

owner/manager of the risks will be able to see them. 

To see a hidden risk: 

1. Click the Risks tab and then in the Risk Views group, click Risk Register or Risky 

Properties. 

2. From Hierarchy based on drop-down list select Visible/Hidden. 

3. You will be able to see all hidden risks for the current project or at the enterprise level, if no 

projects are opened. 
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About the Risk Approval Process 

Risks entered into the system may need to be approved by a manager before they become 

visible to other users. The manager or administrator can make risks assigned to specific 

projects visible in other projects. There are two methods to make projects visible: 

1. Using the Risk Information dialog box (see Changing Risk Visibility) - using this 

method you can only change the visibility for one risk at a time. 

2. Using the Make Visible (Approve) command - you can modify the risk visibility for a 

group of risks. 

To make a hidden risk visible: 

1. Open the project where you want the risk to be visible. If you don’t open any project, the 

risks will be visible at the enterprise level. 

2. Click the Risks tab and then in the Risk Views group, click Risk Register or Risky 

Properties. 

3. Select a single risk or a group of risks. 

4. Right-click on the Risk ID. 

5. Click Make Visible (Approve). 

 

You must be an administrator or a manager to make risks visible. Even if you are the manager or owner 

of a particular risk, you cannot make the risk visible for other levels of the hierarchy. 

 

Deleting Risk Assignments 

Risks can be deleted using the same process as in the standalone RiskyProject (see the 

RiskyProject User Guide for more information). You may: 

• select a risk in the risk register and press Delete , or  

• select a risk or group of risks, right-click on a risk ID and click Delete Risk. 

All risk assignments will also be deleted. If these risks are assigned to the projects you need to 

open projects individually, recalculate them and save them. This will allow the project risk score 

and other information related to project uncertainties to be updated. 
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Calculating Risk Probability and Impacts 

Risk probability, impact and scores for all risks associated with a particular project or at the 

enterprise level are updated each time the risk register is loaded or refreshed: 

• When you click the Refresh button 

• When you close the current project or load a new project 

• When you input a new risk 

• When you switch views to Risk Register, Risk Matrix, RiskyProperties, or Risk Details 

To update the risk register, Monte Carlo simulations are automatically performed. This is 

required to statistically calculate the cumulative impact of each risk. Monte Carlo simulations are 

required because the same risk may be assigned to different projects and within a project’s 

various tasks and resources. The process of impact calculation is outlined in The Project Risk 

Score and Project Ranking. 

The probability for each risk is based on the maximum probability of all risk assignments.  

Locking and Unlocking Risks 

Only one user can edit a risk at a time. Risk editing is done in the Risk Information Dialog box. 

Once a user opens a risk, this risk will be locked for all other users. Locked risks have the icon  

next to the risk name. The risk will be automatically unlocked once risk editing is complete (once 

the user closes the Risk Information Dialog box). 

If a risk is locked it can be unlocked by an administrator. As an example, it may be necessary for 

an administrator to intervene if a user has a risk opened for a long time period.  

To unlock a project or a group of projects: 

1. Click the Risks tab. In the Risks Views group, click Risk Register or Risk Properties view.  

2. Select the risk or multiple risks you would like to unlock.  

3. Right-click on the project ID and from the shortcut menu, click Unlock Risk. 

About Cost of Risk Calculations 

Cost of risk calculates the total cost of a risk that takes into account the risk mitigation plans 

linked to the risk. Cost of risk calculation in RiskyProject Enterprise includes calculation of risk 

cost for subprojects for summary projects and at the enterprise level. The Risk cost calculation is 

performed in the Risk Form tab of the Risk Information dialog box. Only Cost of Residual Risk 

and Potential Loss can be entered in Risk Form. Other cost parameters are calculated. You can 

modify Risk Form to show or hide different fields. 
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Cost Before Mitigation 

1. Potential Loss (property “Cost before mitigation”): the loss in monetary terms if the risk 

occurs. This value can be entered manually if you select No for “Auto calculation of expected 

loss (from Monte Carlo)” or if you don’t open a schedule. 

For example, for the risk “low quality component”, the potential loss is $50,000. You 

would incur this cost if a low quality component were supplied. 

2. If you don’t open a schedule, the Probability Before Mitigation value is based on the risk 

values entered in the Probabilities and Outcome tab of Risk Information dialog box. See 

Risk Probabilities and Impacts for more information. If you have a schedule Probability 

Before Mitigation comes from results of Monte Carlo simulations.  

3. Expected Loss (property “Pre-Mitigation Expected Loss”) takes into account risk 

probability. It is an indicator that helps you to compare the costs of different risks. Expected 

loss can be calculated manually or automatically depending on selection “Auto calculation of 

expected loss (from Monte Carlo)”. 

a. Manual calculation of Expected Loss: You can manually calculate the expected loss 

for individual risks by running two simulations: one with the risk open and the other 

with the risk closed. The difference in the total project costs is the expected cost of 

the risk. 

Expected loss = Potential Loss * Probability (pre-mitigation) 

For example, probability of risk “low quality component” equals 50%. Potential loss 

equals $50,000. Expected loss will be $25,000 = $50,000 * 50%.  

b. Automatic calculation of Expected Loss is done based on results of Monte Carlo 

simulations of project schedule: 

Expected loss = (Project Cost with Risks – Project Cost Original) * 

Correlation Coefficient  

The correlation coefficient is calculated using project cost and cost increases due to a 

specific risk occurring. For example, the project cost with risks and uncertainties is 

$100,000. Project cost without risks and uncertainties is $90,000. In addition, the 

correlation coefficient for the specific risk is 0.8. Expected loss will be ($100,000 - 

$90,000 )*0.8 = $8,000. The automatic calculation cannot be performed at the enterprise 

level or on summary projects, as they do not include project activities. For automatic 

calculation of Expected loss of the current project, RiskyProject will calculate Potential 

Loss for current project = Expected loss / Probability (pre mitigation).  

4. Cost from Subprojects (property “Pre-Mitigation Expected Loss (Sub-Projects)”) is an 

expected cost from all subprojects where “Auto calculation of expected loss (from Monte 

Carlo)” is “Yes”. It is calculated only for summary projects and at the enterprise level. It is 

always zero for subprojects. 

5. Pre-Mitigation Loss (Total Expected Loss): 

Total Expected loss = Expected Loss on Current Level of Project Hierarchy 

+ Cost from Subprojects 

Total expected loss is calculated at the enterprise or at the summary project level. For 

example, a summary project has two sub projects with expected loss $8,000 and $7,000, 
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which are calculated automatically. The summary project itself has expected losses of 

$5,000, defined manually. Total expected loss will be $20,000. 

Total expected loss cannot be shown on Risk Form,  but can be inserted as a column in 

the Risk Register. 

Cost Of Mitigation 

 

1. Cost of Mitigation is taken from Waterfall tab of Risk Information dialog box. It is the cost 

associated with efforts to reduce the probability and impact of the risk.  

For example, mitigation plans will include “Additional QA procedure” and “QA audit of 

supplier’s operation”, which would cost $10,000 in total. 

Cost After Mitigation 

 

2. Cost of Response Plan. Even if a mitigation plan is executed as planned, there will still be a 

cost associated with a risk, as it is possible to reduce risk, but not to eliminate it (an exception 

is when you are able to avoid the risk). The response plan may be executed if the risk occurs 

and will be calculated using the cost entered for the response plan associated with this risk. 

This cost is entered Mitigation and Response view.  

For example, if the risk “low quality component” occurs, this component needs to be 

replaced with a new one, which would cost $20,000. 

3. Residual risk may still exist after the risk response and is cost is calculated as the Cost of 

Residual Risk.  

For example, the new component installed as a risk response can still be defective. The 

residual cost of the risk will be $10,000.  

4. Probability After Mitigation comes from Waterfall tab of Risk Information dialog box. 

See “Risk Mitigation and Response Plans” for more information. 

For example: Risk Probability after mitigation equals 25% because of the execution of 

the mitigation plan “additional QA procedure”, probability of risk “Low quality 

component” is reduced two times. 

5. Expected Loss After Mitigation (property “Post-mitigation Expected Loss”) takes in to 

account the fact that risk may not occur.  

Expected Loss After Mitigation = (Cost of Response Plan + Cost of Residual Risk) * 

Probability After Mitigation 

For example, probability of risk “low quality component” after mitigation equals 25%. 

Expected loss after mitigation will be $7,500 = ($20,000 + $10,000) * 25%. 

Other Cost Indicators (Properties) 

 

1. Cost After Mitigation = Expected Loss After Mitigation + Cost of Mitigation 

For example: Total cost after mitigation of risk “low quality component” will be $17,500 

= $7,500 + $10,000 
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2. Saving from Mitigation/Enhancement is the difference between costs with and without 

mitigation. If this number is negative mitigation efforts will not lead to cost saving. 

Saving from Mitigation = Expected Loss – Total Risk Cost after Mitigation 

For example, total cost after mitigation of risk “low quality component” will be $17,500. 

Expected loss $25,000. Saving from Mitigation is $7.500. Because this number is 

positive, it makes sense to perform mitigation efforts. 
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About Risk Documents 

You can add documents related to a risk to the risk register as part of your risk management 

process. This can be useful in order to add artifacts that were used during risk identification, 

assessment or other processes that are considered important to managing the current risk, but also 

for future reviews. 

To add a document to a risk: 

1. Open the risk register. 

2. Open the risk to which you want to add the document. 

3. Click the Documents tab.  

4. You can manage existing documents using the following buttons: 

• Extract Document: Click to extract a copy of a document saved to the database onto a 

local drive.  

• Update Document: Click to update a linked document. 

• Delete Document: Click to delete a document from the risk. 

 

  

Click these buttons to extract, 
update or delete a selected 
document. 

Documents are listed here. 

Click to add a document 
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Adding a Document to a Risk 

To add a document to a risk: 

1. Open the Document tab. 

2. Click the Add or Link Document button. The Document Description dialog box will open. 

3. Type in a document name in the Document Name box. 

4. Type in a description of the document in the Document Description box. 

5. Select either the Add link or Save document in the database option. 

There are some considerations you should note in regards to these options: 

• If you choose to link a document, this provides a path to the local computer. Therefore, it 

may not be valid for other system users. 

• If you select Add to database, over time this can potentially impact database size and 

may lead to decreased performance.  

6. Click the Browse button to locate the file. 

7. Click OK. 
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Risk Register and Organizational Units 

The Risk Register can be filtered based on organizational units. The Organizational breakdown 

structure is defined in User Management console. For more information about organizational 

breakdown structures, please refer to The RiskyProject Enterprise Administrator’s Guide. 

Each risk can have organizational unit as a risk property. Organizational Unit risk property is a 

dropdown list defined in User Management dialog. It is possible to assign Organizational Unit 

properties: 

• In the Risk Form (Risk Information Dialog) 

• In the Custom Properties tab of Risk Information Dialog 

• In the Risk Register view directly by inserting Organizational Unit column in Risk 

Register grid.  

 

 

Once Organizational Units are defined, you can filter the Risk Register based on organizational 

units. The Organizational Units are selected using the drop-down list located at the right top 

corner of the  Risk Register, Risk Matrix, and Risk Trend views. 

Filtering the Risk Register based on an organizational unit takes into account the Organizational 

Hierarchy or Organizational Breakdown Structure. For example, if you have Organizational Unit 

“Administration” and it has two subunits “Accounting” and “HR”. In this case, in the Risk 

Register, if you select “Administration”from drop down list, risks that belong the the organization 

untils  “Accounting” or “HR” will be shown. 

If you select “Company Level” from “Organizational Unit” downdown list, you will be presented 

with all visible (approved) risks in Risk Register. 

Define Organizational 
unit using Risk Form 

You can also define 
Organizational unit using 
Custom Properties Tab of 
Risk Information Dialog 
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Select Organizational Unit 
from dropdown list to filter 
Risk Register. 

Click here to expand 
dropdown list of org units 
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Managing Mitigation and Response Plans 

In RiskyProject risk mitigation and response plans are available for all projects and organizational 

units. Risk Mitigation and response plan can be entered and edited in Mitigation and Response 

View. RiskyProject Enterprise allows linking mitigation and response plans not only to individual 

task as in standalone desktop version, but also to a project. If you associate plan with entire 

project cost, actual cost, and percent completed of entire project will be used in mitigation plan. 

To link mitigation or response plan with a project or a task: 

1. Open a project. This project will become current 

2. On the Risks tab,  click Mitigation and Response to open the view. 

3. Double click on the Mitigation or Response Plan ID; the Mitigation of Response Plan 

properties dialog box opens.  

4. Select task from the list of tasks; only one task can be selected. 

5. If you want this mitigation and response plan to be associated with the current project, select 

the checkbox the at bottom of dialog box.   

To reset the selection of the task and project, click Clear task selection.  

 

Enter description of the mitigation or 
response plan 

Select task associated with mitigation or 
response plan from the list 

 

Use this checkbox to indicate that this 
mitigation plan will be associated with 
entire project 
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Managing Incidents 

Incidents are events that can be recorded, viewed and reported in RiskyProject. In RiskyProject, 

incidents are managed similarly to risks. RiskyProject has an Incident Register. This register is 

similar to Risk Register. Each Incident has a list of customizable properties that are a different set 

than risk properties. Risks and incidents can be linked to each other: one risk may have different 

incidents, while one incident may have multiple risks. Incidents have customizable impact 

classifications such as Severe Impact, Moderate Impact, Low Impact. The Incidents feature is 

only available in RiskyProject Enterprise and requires connection to a database.  

These views can be accessed using Incident tabs within the workflow bar or ribbon:  

1. Incidents in the  Incident Register 

2. Incident Statistics as a chart showing occurrence of incidents over time 

Enabling Incident Register 

To enable Incidents Tabs in Workflow Bar and Ribbon: 

1. On the Projects tab, click Portfolio Options > General tab.  

2. Click Enable incident tracking and reporting (Incident tab). 

3. Click OK. Incidents are now available.  

Incident Classification 

You can define incident classifications and how incidents appear on the Incident Statistics chart.  

The order of the bars on the Incident Statistics are associated with particular incident classes 

(groups). For example, for each time period Low (green), Moderate (yellow), and Severe (Red 

color) are first, second, and third respectively. 

Using Incident Classification Settings dialog box you can define: 

1. The order using the Move Up and Move Down buttons. 

2. The class name (group). 

3. Chart periodicity (monthly, quarterly, yearly, etc.) 

4. Maximum number of periods on the Statistics chart. 

To open the Incident Classification Settings in Incidents tab, click Classification in the Settings 

group. 
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About Incident Properties 

Similarly, to risks each incident has properties that record information about the incident. You 

can use incident properties to search and filter the Incident Register. Incident properties can be 

have the following types: 

• String – text information 

• Integer number  

• Real number 

• Resource – can be taken from list of resources 

• Date 

• Picklist: dropdown list with values 

Integer numbers and real numbers have maximum and minimum values. 

The list of incident properties supports a hierarchy and organized  into groups.  

Customizing the default incident properties 

To customize the incident properties: 

1. Click the Incident tab > Settings group > Default Properties. 

2. Select a row under which you want to add a new incident property. 

3. Right-click on the row number and choose New Property Item. 

4. Type in the name. 

5. Select the type and required values (i.e maximum and minimum values ).  

4. Use the Indent and Outdent arrows  to create groups of incident properties. 

5. If you have Picklist type incident property double-click on incident property ID; Picklist 

dialog box will opens where you can enter the list of values. 

Default incident properties are saved in the database and can be used for all projects. You may 

use the Restore Default button to overwrite changes in default incident properties you made with 

standard set of incident properties 

Incident ID Settings 

You can generate Incident IDs automatically. Alternatively, you can enter Incident IDs manually 

in the same manner as you enter any other incident property. If an Incident ID is generated 

automatically, you can overwrite it manually. Incident IDs will be incremented each time you 

enter a new incident. 

Incident IDs can include four components: 

1. Prefix – any symbols (optional) 

2. Number – from 4 to 16 digits (optional)  

3. Suffix – any symbols (optional) 

4. Date – date format can be defined (optional) 
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The Incident ID may be not unique if you manually overwrite automatically generated IDs. 

To enable automatic generation of Incident ID and define the format of Incident ID: 

1. Click the Schedule tab. In the Settings group, click Options. 

2. Click the Incident tab. 

3. Click on Incident ID Format to define rules for Incident ID automatic generation; Incident 

ID Format dialog box opens. 

4. Define the Incident ID prefix and suffix. 

5. Define the number of digits for Incident ID generation. 

6. Enable / disable dates as part of the Incident ID format and define the date format and 

position. 

7. Define starting number of Incident ID 

Viewing the Incident Register 

The Incident view allows you to: 

• View a list of incidents with their properties; you can use different incident hierarchies 

based on classification, owner, or manager 

• Sort and filter the Incident Register by clicking on the icon on the right corner of the 

column header; to undo filtering click on Show All in left corner of the view.  

• Insert or delete columns with incident properties, define headers for any individual 

column or group of columns; 

• Create multiple views or tabs shown at the bottom of the view; each view may have 

different sets of columns and filters 

• Edit incident properties either within a view directly or using Incident Information Dialog 

(double click on Incident ID) 

• Print the Incident Register  

• Export to Excel 
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List of Incidents with 
their properties 

Double-click ID s to edit 
properties and assign 
incidents to risk 

Select incident hierarchy 
based on classification, 
owner, or manager Sort and filter incidents 

Create multiple views with different 
sets of columns and filters 

Reset Filters 
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Viewing the Incident Statistics Chart 

The Incident Statistics view is used to show the number of issues raised over time for each 

particular classification. Each classification can be modified. To edit colors, order, number of 

periods, and periodicity (yearly, monthly, etc) use  the Incident -> Classification dialog box. 

 

Define classification 
properties, including 
order and colors 

View incidents raised 
in different period of 
time 

Incident 
classes 
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Editing Incident Information 

To edit incident information: 

In Incident view or Incident Statistics view double click on incident ID. The Incident 

Information dialog box will open.  

Incident Information Dialog box includes the following tab: 

• General Tab: allows you to edit Incident Name, Incident ID, Date and Time of Incident, 

Incident description, Incident follow up actions. 

• Custom Properties: allows you to edit all individual custom properties. 

• Associated Risks: allows you to assign risks to the incident. 

 

 

 

 

You can assign incidents to risks in  the Incidents tab of the  Risk Information dialog box. When in the 

Risk Register  you can double-click on a risk ID and go to Incident tab. 

 

  

Click to assign 
incidents to risks 

Edit incident 
properties 

Edit general information: description, 
follow up actions, date and time 
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Chapter 4: User Management and 
RiskyProject Configuration 
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About User Management 

In RiskyProject Enterprise, user management is based on users, roles and permissions. Each 

individual who accesses the system should be assigned user logon credentials which are defined 

in the User Administration panel. Users can be assigned one of three roles: Administrator, 

Manager or User. The RiskyProject Enterprise Administrator’s Guide describes the user 

management process. This section describes only how the user can define personal information. 

About Roles 

RiskyProject Enterprise has 3 defined roles that can be assigned to users: Administrator, Manager 

and User.  

• Administrator: the administrator has full access to RiskyProject functions. 

• Manager: the manager may have full access to RiskyProject, except for the ability to 

manage users and change user permissions. The manager’s permissions can be limited by 

the administrator. 

• User: the users cannot edit managers, users, modify portfolio settings, or delete projects. 

In addition, the administrator can limit a user’s permissions. 

Only administrators can edit user information. A user can only edit their own information, 

including passwords. The administrator cannot set or modify user passwords. Only administrators 

and managers can change risk visibility information.  

Updating Personal Information 

To update personal information: 

1. From the File menu, click Users. The User Management panel will open. 

2. Review your permissions - permissions cannot be changed by users.  

3. Update your personal information. 

4. Click OK. 

About Permissions 

Each user has different permissions: 

• Create, modify and delete risks 

• Create, modify and delete mitigation and response plans 

• Create projects 

By default, the Administrator role has all available permissions. Only administrators can change 

permissions for users and managers. For more information about how to change user permissions, 

please read the RiskyProject Enterprise Administrator’s Guide. All administrators, managers and 

users can view all projects and all visible risks. However, if a user does not have permission to 

modify a risk or a mitigation/response plan, the Risk Information or Mitigation Plans will be 

read-only. If a user attempts to open the project to which they do not have permission, they will 

be prompted that they do not have permission to perform this action.  
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• You can always create risks in projects to which you have permission. However, you need 

permissions to create risks at the enterprise level. 

• Both managers and administrators can approve (make visible) risks at each level of the 

project hierarchy. 

• A user can always modify risks as soon as he or she is listed as an owner or a manager for this 

risk. 

• A user or manager must have permissions for all projects (the entire portfolio) to be able to 

create risks at the enterprise level. 

• If you use the RiskyProject add-in in Microsoft Project and the project does not exist in the 

RiskyProject database, it will automatically be created in RiskyProject regardless of user 

permissions. 
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Notification Manager 

In RiskyProject, you can configure emails which will be sent to users to notify them regarding the 

status of risks, changes in their properties and upcoming risk reviews. Who needs to receive 

messages, what those messages are and when they will be sent are all fully configurable by 

administrators.   

RiskyProject can be executed using Windows Task Scheduler every 5 – 15 minutes without 

preventing user interface and can send out notification e-mails. Notifications can be configured 

using Notification Manager. Notification Manager is accessible from Tools -> Notification 

Manager or from File -> Users -> Users Tab -> Notification Manager. After notifications are 

configured, RiskyProject can read data from notification messages in the RiskyProject database 

and send them.  

To execute RiskyProject using Windows Task Scheduler to send notification messages, it is 

recommended to install RiskyProject Professional, Lite, or Risk Register on the server. This 

installation can be done exactly the same way as on a client’s computer. A dedicated user can be 

created to execute RiskyProject for notification messages. The user name and password for 

RiskyProject installed on the server will be encrypted and saved in the registry. When 

RiskyProject is executed by the Task Scheduler, no interface will be prevented and user name and 

password will not be asked. For more information about how to configure a Windows Task 

Scheduler, please read the RiskyProject Enterprise Administrator’s Guide.  

 

 

 

 

 

 

 

 

 

 

Configuring Notification Messages 

To start Notification Manager: 

1. Go to Tools  

2. Click on Notification Manager  

Or 

1. Go to File 

2. Click on Users - the User dialog will come up 

3. Go to Users Tab  

4. Click on Notification Manager 

 

RiskyProject 

Professional 

Generate 

Notification 

Events 

RiskyProject 

Database 

 

RiskyProject 

Professional 

 

RiskyProject 

Professional, Lite or 

Risk Register 

 

“Silent” RiskyProject 

Professional, Lite or 

Risk Register 

 

Notification 

Events 

On Client Computer On Server 

Send 

e-mails 

Update e-mail 

log 
View e-mail 

log 
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The Notification Messages tab allows you to configure individual messages. Double-click 

message ID to enter text for the message. You can use the buttons Risk, First Name, Last Name 

to substitute the message text with risk name and name of the message recipient. 

 

 

You can define multiple risk review reminder messages if you you want to send reminders at 

different times, for example, one hour, one day or one week in advance. 

 

Viewing Sent Notification E-mails 

You can view all notification event e-mails which have been sent using the Notification Events 

tab of Notification Manager. To copy, delete or view details of notification messages: 

1. Right click on the message ID 

2. Select copy, delete or view details of notification messages from the dropdown menu 

3. If you select View details, you will be presented with a dialog which will include an error if a 

message was not sent.  

You can click the Sent button if you wish to force sending notification messages without waiting 

for the execution of a scheduled process. 

You can also limit the number of records of sent messages stored in the RiskyProject database. 

Each time the scheduled process to send messages is executed, it will delete the oldest messages. 

Configuring E-mails 

You can configure how to send notification messages using the Configure E-mail tab of 

Notification Manager. This tab consists of two sections: 

Risk review 
reminders can be 
sent instantly or in 
advance; other 
messages are sent 
instantly 

Messages can be sent to: 

- Owner 
- Contact 
- Manager 
- Recorder 
- Upper management of 

owner one level up 

Select different 
types of 
messages 

Double click on 
message ID to 
define 
message text 

Enable or 
disable 
messages 
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1. The upper section allows you to configure email server settings. It includes information about 

your e-mail server, port, encoding, etc. E-mail settings will be saved in the system registry. 

2. The lower section allows to you send test e-mails to ensure that settings are correctly 

configured. 

 

 

 


